
 

FILE OPERATIONS 

2R Net is capable of reading and writing .2rn files, which contain the complete description of a specific network 

model: 

1. Coordinate System. 

2. Coordinates and names of all the nodes. 

3. Connectivity Matrix. 

4. Weight Matrix. 

5. Failure Probability Matrix. 

6. Capacity and Demand Matrices. 

These files are the means for 2R Net users to save their work, as well as the medium of distribution of network 

models that could be of interest to other 2R Net users. 

 

SAVING NETWORK MODELS 

At any given time, a user can decide to save a network model’s information for later use. In order to do this, the 

user must navigate through the File menu and select the Save or Save As… option: 

 

The difference between Save and Save As… is that, while Save will only ask for the file’s name and destination 

once and will then overwrite that same file on any subsequent uses, Save As… will ask for the file’s name and 

destination every time it is invoked. Thus, Save As… is to be used whenever a user wants to save modifications 

made to a file without modifying the base file. 

OPENING DATA MODELS 

In order to load the information contained inside a .2rn file, the user must navigate through the File menu and 

select the Open option: 

 

If no errors occur, the loaded model is shown in the main window (Main, Connectivity, Weight Matrix, etc). 



STARTING NEW NETWORK MODELS 

If a user is done working with a network model and wants to start a new one, the New option from the File menu 

provides this functionality: 

 

Before the new model is created, the user is given the chance to save his current work. 

 

DATA INPUT 

INPUTTING AND MODIFYING DATA 

2R Net offers a straight-forward editing interface in the main window for users to declare the network’s nodes, 

connectivity matrix, weight matrix, etc. The following table summarizes the different actions that a user can carry 

out in 2R Net’s editor: 

Action How To 

Add nodes 1. Select the Main tab’s last cell (the one that is always blank). 
2. Write a coordinate or name to be added. 
3. Hit the ENTER key. 
4. Repeat steps 2 and 3 until all the nodes have been added. 

Modify a specific cell of a matrix There are two ways of going about this task: 

 Double-click over the cell that contains the value to be edited, make 
the desired changes, and then hit the ENTER key. 

 To overwrite a value, select the appropriate cell (single click) and 
write the new value. Then, hit the ENTER key. 

Delete a node 1. In the Main tab, select a cell located on the row that describes the 
node that you want to delete. 

2. Hit the DEL or DELETE key. You can also go to the Edit menu and 
click on the Delete Selected Data Point (DEL) option. 

 

 

 

 

 

 

 

 



NAVIGATION WITHIN A MATRIX 

2R Net uses NxN matrices as input when dealing with N nodes. This makes navigation within each matrix 

(connectivity, weight, demand, etc) relatively difficult if the user limits itself to the arrow keys. For this reason, 

every matrix explicitly tells the user which cell is currently selected: 

 

Cell (i, j) is that located at row i and column j, and represents a network property (weight, connectivity, etc) 

FROM i TO j. 

If a user wants to jump to a specific cell in a matrix, the Go to cell… option in the Edit menu enables him to do so. 

After selecting that menu option, the user is prompted for the row and column of interest. 

 

 

 

 

 

 



MAIN TAB 

The main tab describes the network’s nodes and their coordinates. 2R Net only supports one-dimensional and 

two-dimensional vector spaces. 

 

The coordinate system is an important setting that affects most of the analysis results. This setting can be changed 

through the Coordinate System menu: 

 

When X/Y is selected, distances are calculated as if the nodes were located on the Euclidean plane: 

  √(     )
  (     )

  

On the other hand, if LAT/LON is selected, nodes are taken to be on the Earth’s surface. In that case, 2R Net uses 

the Haversine Formula to calculate the great-circle distance between each pair of points – that is, the shortest 

distance over the earth’s surface – giving an ‘as-the-crow-flies’ distance between the points (ignoring any hills, of 

course!) (Type 2011). 

 

CONNECTIVITY MATRIX 

The connectivity matrix indicates the presence of direct paths between pairs of nodes. If an edge is connecting 

node i with node j in that direction (ij), cell (i, j) must have a value of 1. A value of 0 in cell (i, j) indicates that 

there is no direct connection from i to j. If cell (i, j) and cell (j, i) have a value of 1, a bidirectional link is said to 

exist between nodes i and j. 

 

 



WEIGHT MATRIX 

The weight matrix indicates the “cost” associated with traveling through a link. Cell (i, j) of this matrix expresses 

the cost of directly going from node i to node j. If there is no edge from node i to node j, then the weight of that 

link is infinite. The weight matrix has two settings: 

 Distance-Based Weights: weights are calculated to be the same as the distance covered by each link. 

Refer to the Main Tab section to learn how distances are calculated in 2R Net. This setting makes sense 

when all of the links have similar properties. For example, when modeling a water distribution system 

with pipes of the same diameter and material regardless of the path. 

 Arbitrary Weights: arbitrary weights are manually entered by the user. This setting should be used when 

the cost of traveling from one point to another isn’t necessarily dependent on the distance between 

them. For example, a computer network can have some high-speed links between nodes with bandwidths 

of 100 Gbps and other links with bandwidths as low as 128 kbps. Thus, data transfer can be less costly on 

longer links than shorter ones if they provide a higher transfer rate. 

 

FAILURE PROB. MATRIX 

The failure probability matrix defines the probability (from 0 to 1) of failure of each link. Cell (i, j) of this matrix 

indicates how probable it is that the link connecting node i to node j in that direction (ij) seizes to work. If there 

is no edge from node i to node j, then the probability of failure is automatically 0. This matrix also defines the 

probability of failure of a node. Cell (i, i) of this matrix indicates how probable it is that node i seizes to work. 

When a node fails, any incoming and outgoing traffic for that node is lost, and paths relying on that node stop 

working as well. 

The failure probability matrix works under two modes. Regardless of the mode, the user is expected to manually 

enter the probability failure for each node (matrix main diagonal), since that network characteristic is always 

arbitrary. 

 Arbitrary Prob.: arbitrary probabilities are manually entered by the user. This setting makes sense when 

failure probability isn’t directly dependent on the distance covered by each link. 

 Prob.=f(distance): if failure probability is a function of link length, then this setting should be selected. A 

prob/distance unit factor is used to calculate the probability of failure of a link based on the distance 

between the nodes that it connects. Failure Prob. (i, j) = [prob/distance unit factor] * [distance (i, j)]. 

Refer to the Main Tab section to learn how distances are calculated in 2R Net. 

 



 

DEMAND AND CAPACITY MATRICES 

The capacity and demand matrices are only used for the Max. Flow (Edmonds-Karp) analysis. In the capacity 

matrix, cell (i, j) expresses the amount of traffic that can be handled by the link that goes from node i to node j. 

Meanwhile, each cell in the demand matrix expresses the amount of traffic that wishes to travel through each link 

(ij). All of the capacity and demand values have to be input by the user. 

 

 



PASTING DATA FROM EXCEL 

Given that Microsoft Excel is the de facto standard for spreadsheet management, 2R Net has been enhanced to 

allow an intuitive flow of information with that program. Therefore, users can copy and paste data from Excel into 

the 2R Net user interface with ease, both by using hotkeys and by using explicit menu options. 

METHOD 1 - HOTKEYS 

1. In Microsoft Excel, highlight the data values that you wish to paste into a 2R Net model: 

 

2. Then, press the CTRL and the C keys simultaneously (ctrl+c). 

3. In 2R Net’s main window (Main, Connectivity, Weight Matrix, Failure Prob., or Capacity/Demand tab), select the 

cell that will act as the top-left cell of the imported data. Warning: the Excel data will overwrite data values of the 

current model if the position of the imported values coincides with the position of existing values. 

 

4. Press the CTRL and the V keys simultaneously (ctrl+v). 

 

 

 



 

5. The data is copied to 2R Net: 

 

Note that, as the warning from step 3 suggests, some values from the matrix got overwritten by the Excel data. 

METHOD 2 – EXPLICIT MENU OPTIONS 

1. In Microsoft Excel, highlight the data values that you wish to paste into a 2R Data model: 

 

2. Right click over the selection and select the Copy option. 

 

 



3. In 2R Net’s main window (Main, Connectivity, Weight Matrix, Failure Prob., or Capacity/Demand tab), select the 

cell that will act as the top-left cell of the imported data. Warning: the Excel data will overwrite data values of the 

current model if the position of the imported values coincides with the position of existing values. 

 

5. Navigate through the Edit menu and click over the Paste Excel Data option. 

 

6. The data is copied to 2R Data: 

 

Note that, as the warning from step 3 suggests, some values from the matrix got overwritten by the Excel data. 



EXPORTING DATA 

Even though 2R Net provides a variety of ways to analyze a network, some users might want to carry out 

operations on a network model’s information with other software packages. For that reason, 2R Net users are 

given the option to export a model’s data values to XLSX (Excel 2007) format. The option to do this is located under 

the Export menu and is labeled as Export Data to Excel. 

 

 

The resulting excel contains all of the model’s matrices organized in separate tabs: 

 

 

 



BASICS 

GRAPHS 

All of the graphs generated in 2R Soft provide a wide array of options in the form of a context menu. The context 

menu appears when you right-click over a graph: 

 

PROPERTIES PANE 

If you select the Properties… option, a properties pane appears. The properties pane lets you change the graph 

title, axis names, axis ranges, and font size. 

 

 

 

 



COPY AND SAVE AS…  

If you select COPY, the graph is copied to the system clipboard, so you can PASTE it anywhere else (Microsoft 

Word, Microsoft PowerPoint, etc). 

Meanwhile, if Save As… is selected, 2R Soft will save the graph as a PNG image file in your hard disk after selecting 

the desired output folder and file name: 

 

PRINT 

The Print option does just that: it sends the graph to the printer of your choice (local or networked): 

 

SCALE OPTIONS 

The Auto Range, Zoom In, and Zoom Out options are a quick way to inspect the graph. If a very specific range is 

needed for an axis, we highly recommend the Properties Pane. 



MANUAL ZOOM IN 

For user convenience, all 2R Soft graphs support manual zoom in by regions. If you’re interested in a specific 

region, hold your left-click and drag the mouse to generate a highlighted box around that region: 

 

The end result: 

 

NORMALIZED AND CUMULATIVE HISTOGRAMS 

Normalized and Cumulative histograms are found all throughout 2R Soft. These two types of graphs are of great 

importance, considering that they show the stochastic tendencies of a data set. With them, a goodness-of-fit table 

is displayed with various probability distributions and the best estimates for their parameters, along with different 

goodness-of-fit tests: 

 

The distribution selected in the goodness-of-fit table is juxtaposed with the histograms (red curve). 



PROBABILITY DISTRIBUTION TYPES 

When declaring a variable with a known distribution, the user can select one of many types of probability 

distributions. 

Distribution Description Parameters 

Beta The beta distribution has shape parameters α > 0 and β > 0 over the 
interval (a, b), where a < b. 
 
It has density: 
f (x) = (x - a)α-1(b - x)β-1/[B(α, β)(b - a)α+β-1] 
for a < x < b, and 0 elsewhere. 
 
It has the following distribution function: 
F(x) = Iα, β(x) = ∫a

x(ξ - a)α-1(b - ξ)β-1/[B(α, β)(b - a)α+β-1]dξ,  for a < x < b 
 
(Simard) 

Alpha – shape parameter, alpha > 0 
Beta – shape parameter, beta > 0 
a – lower bound of the interval 
b – upper bound of the interval, b > a 

Binomial The binomial distribution with parameters n and p, where n is a 
positive integer and 0 <= p <= 1. Its mass function is given by: 
p(x) = nCr(n, x)px(1 - p)n-x = n!/[x!(n - x)!]  px(1 - p)n-x  for x = 0, 1, 2,…n, 
 
and its distribution function is: 
F(x) = ∑j=0

xnCr(n, j)  pj(1 - p)n-j        for x = 0, 1, 2,…n, 
where nCr(n, x) is the number of possible combinations of x elements 
chosen among a set of n elements. 
 
(Simard) 

p – probability of success on each trial 
       (0  p 1) 
n – number of trials (integer),  n > 0 

Chi Square The chi-square distribution with n degrees of freedom, where n is a 
positive integer. Its density is: 
f (x) = x(n/2)-1e-x/2/(2n/2Γ(n/2)),         for x > 0 
where Γ(x) is the gamma function. The chi-square distribution is a 
special case of the gamma distribution with shape parameter n/2 and 
scale parameter1/2. 
(Simard) 

n – degrees of freedom (integer), n>0 

Deterministic Distribution that represents a constant value, val. Consequently: 

 ( )  {
          
          

    ( )  {
          
          

 

Value – any real number 

Discrete Uniform The discrete uniform distribution over the integers in the range [i, j]. Its 
mass function is given by: 
p(x) = 1/(j - i + 1)         for x = i, i + 1,…, j 
and 0 elsewhere. 
 
The distribution function is: 
F(x) = (floor(x) - i + 1)/(j - i + 1)         for i <= x <= j 
and its inverse is: 
F-1(u) = i + (j - i + 1)u        for 0 <= u <= 1. 
 
(Simard) 

Min. – lower bound (integer) 
Max. – upper bound (integer) 
             (Max. > Min.) 

Exponential The exponential distribution with mean 1/λ where λ > 0. Its density is: 
f (x) = λe-λx        for x >= 0, 
its distribution function is: 
F(x) = 1 - e-λx,        for x >= 0, 
and its inverse distribution function is: 
F-1(u) = - ln(1 - u)/λ,        for 0 < u < 1 
 
(Simard) 

Lambda – rate parameter, lambda > 0 

F-Distribution The Fisher F distribution with n and m degrees of freedom, 
where n and m are positive integers. Its density is: 
f (x) = Γ((n + m)/2)nn/2mm/2/[Γ(n/2)Γ(m/2)]x(n-2)/2/(m + nx)(n+m)/2, for x > 0. 
where Γ(x) is the gamma function 
 
(Simard) 

D.O.F. 1 – the n degrees of freedom                                                                                
                  (integer), D.O.F. 1 > 0 
D.O.F. 2 – the m degrees of freedom                                                                                
                  (integer), D.O.F. 2 > 0 



Gamma The gamma distribution with shape parameter α > 0 and scale 
parameter λ > 0. The density is: 
f (x) = λαxα-1e-λx/Γ(α),        for x > 0, 
where Γ is the gamma function, defined by: 
Γ(α) = ∫0

∞xα-1e-xdx. 
 
In particular, Γ(n) = (n - 1)! when n is a positive integer. 
 
(Simard) 

Alpha – shape parameter, alpha > 0 
Lambda – scale parameter, lambda>0 

Geometric The geometric distribution with parameter p, where 0 < p < 1. Its mass 
function is: 
p(x) = p (1 - p)x,        for x = 0, 1, 2,… 
The distribution function is given by: 
F(x) = 1 - (1 - p)x+1,        for x = 0, 1, 2,… 
and its inverse is: 
F-1(u) = floor(ln(1 - u)/ln(1 - p)),        for 0 <= u < 1 
 
(Simard) 

p – probability of success on each trial   
       (0 < p < 1) 

Gumbel The Gumbel distribution, with location parameter δ and scale 
parameter β≠ 0. Using the notation z = (x - δ)/β, it has density: 
f (x) = e-ze-e-z/| β|,        for - ∞ < x < ∞. 
and distribution function: 
F(x) = e-e-z,        for β > 0 
F(x) = 1 - e-e-z,        for β < 0 
 
(Simard) 

Beta – scale parameter, beta   0 
Delta – location parameter, any real  
              number 

Hypergeometric The hypergeometric distribution with k elements chosen 
among l, m being of one type, and l - m of the other. The 
parameters m, k and l are positive integers 
where 1 <= m <= l and 1 <= k <= l. Its mass function is given by: 
 
p(x) = nCr(m, x)nCr(l - m, k - x)/nCr(l, k) 
for max(0, k - l + m) <= x <= min(k, m) 
where nCr(n, x) is the number of possible combinations of x elements 
chosen among a set of n elements. 
 
(Simard) 

m – number of elements of one type  
        (integer),   m > 0 
l – total elements (integer), l > 0 
k – number of elements chosen  
      among l (integer), k > 0 

Logistic The logistic distribution. It has location parameter α and scale 
parameter λ > 0. The density is: 
f (x) = (λe-λ(x-α))/((1 + e-λ(x-α))2)                for - ∞ < x < ∞. 
and the distribution function is: 
F(x) = 1/[1 + e-λ(x-α)]                for - ∞ < x < ∞. 
 
For λ = 1 and α = 0, one can write: 
F(x) = (1+tanh(x/2))/2. 
 
The inverse distribution function is given by: 
F-1(u) = ln(u/(1 - u))/λ + α        for 0 <= u < 1 
 
(Simard) 

Alpha – location parameter, any real  
               number 
Lambda – scale parameter, lambda>0 

Lognormal The lognormal distribution. It has scale parameter μ and shape 
parameter σ > 0. The density is: 
f (x) = ((2π)1/2σx)-1e-(ln(x)-μ)2/(2σ2)    for x > 0, and 0 elsewhere. 
 
The distribution function is: 
F(x) = Φ((ln(x)-μ)/σ)        for x > 0, 
where Φ is the standard normal distribution function. 
 
Its inverse is given by: 
F-1(u) = eμ+σΦ-1(u)        for 0 <= u < 1 
 
If ln(Y) has a normal distribution, then Y has a lognormal distribution 
with the same parameters. 
 
(Simard) 

log mu – scale parameter, any real 
                 number 
log sigma – shape parameter, 
                     log sigma > 0 



Negative Binomial The negative binomial distribution with real parameters γ and p, 
where γ > 0 and 0 <= p <= 1. Its mass function is: 
p(x) = Γ(γ + x)/(x! Γ(γ))pγ(1 - p)x,        for x = 0, 1, 2,… 
where Γ is the gamma function. 
 
If γ is an integer, p(x) can be interpreted as the probability of 
having x failures before the γ-th success in a sequence of 

independent Bernoulli trials with probability of success p.  
 
(Simard) 

Gamma – number of failures until the 
                   experiment is stopped,  
                   Gamma > 0 
p – success probability in each  
       experiment, 0  p 1 

Normal The normal distribution. It has mean μ and variance σ2. Its density 
function is: 
f (x) = e-(x-μ)2/(2σ2)/((2π)1/2σ)   for - ∞ < x < ∞ , where σ > 0. 
 
When μ = 0 and σ = 1, we have the standard normal distribution, with 
corresponding distribution function: 
F(x) = Φ(x) = ∫-∞

xe-t2/2 dt/(2π)1/2        for - ∞ < x < ∞. 
 
(Simard) 

Mean – self-explanatory, any real  
               number 
Standard Deviation – self-explanatory, 
                                       Std. Dev. > 0 

Pareto The Pareto family, with shape parameter α > 0 and location 
parameter β > 0. The density for this type of Pareto distribution is: 
f (x) = αβα/xα+1   for x >= β, and 0 otherwise. 
 
The distribution function is: 
F(x) = 1 - (β/x)α        for x >= β, 
 
and the inverse distribution function is: 
F-1(u) = β(1 - u)-1/α        for 0 <= u < 1 
 
(Simard) 

Alpha – shape parameter, alpha > 0 
Beta – location parameter, beta > 0 

Poisson The Poisson distribution with mean λ >=  0. The mass function is: 
p(x) = e-λλx/(x!),        for x = 0, 1,... 
and the distribution function is: 
F(x) = e-λ∑j=0

x  λj/(j!),        for x = 0, 1,.... 
 
(Simard) 

Lambda – mean, lambda   0 

Student's T The Student-t distribution with n degrees of freedom, where n is a 
positive integer. Its density is: 
f (x) = [Γ((n + 1)/2)/(Γ(n/2)(πn)1/2)][1 + x2/n]-(n+1)/2     for - ∞ < x < ∞, 
where Γ(x) is the gamma function 
 
(Simard) 

D.O.F – degrees of freedom (integer), 
               D.O.F > 0 

Triangular The triangular distribution with domain [a, b] and mode (or shape 
parameter) m, where a <= m <= b. The density function is: 

f (x) = 2(x - a)/[(b - a)(m - a)]          for a <= x <= m, 

f (x) = 2(b - x)/[(b - a)(b - m)]          for m <= x <= b, 

f (x) = 0          elsewhere, 

 
the distribution function is: 

F(x) = 0          for x < a, 

F(x) = (x - a)2/[(b - a)(m - a)]          if a <= x <= m, 

F(x) = 1 - (b - x)2/[(b - a)(b - m)]          if m <= x <= b, 

F(x) = 1          for x > b, 

 
and the inverse distribution function is given by: 

F-1(u) = a + ((b - a)(m - a)u)1/2          if 0 <= u <= (m - a)/(b - a), 

F-1(u) = b - ((b - a)(b - m)(1 - u))1/2          if (m - a)/(b - a) <= u <= 1 

 
(Simard) 

a – lower bound of the domain, any  
      real number 
b – upper bound of the domain, any  
       real number 
mode – shape parameter, any real  
               number 
 
“a   mode   b” must be satisfied 



Uniform The uniform distribution over the interval [a, b]. Its density is: 
f (x) = 1/(b - a)     for a <= x <= b, and 0 elsewhere. 
 
The distribution function is: 
F(x) = (x - a)/(b - a)         for a <= x <= b 
 
and its inverse is: 
F-1(u) = a + (b - a)u        for 0 <= u <= 1 
 
(Simard) 

Min. – lower bound 
Max. – upper bound 
             (Max. > Min.) 

Weibull The Weibull distribution with shape parameter α > 0, location 
parameter δ, and scale parameter λ > 0. The density function is: 
f (x) = αλα(x - δ)α-1e-(λ(x-δ))α        for x > δ. 
 
the distribution function is: 
F(x) = 1 - e-(λ(x-δ))α        for x > δ, 
 
and the inverse distribution function is: 
F-1(u) = (- ln(1 - u))1/α/λ + δ        for 0 <= u < 1 
 
(Simard) 

Alpha – shape parameter, alpha > 0 
Lambda – scale parameter, lambda>0 
Delta – location parameter, any real  
              number 

GOODNESS-OF-FIT (GOF) STATISTICS 

To decide whether to accept or reject a proposed probability distribution for the generated data, it is necessary to 

at least use one goodness-of-fit statistic as a criterion. 

Col. Test Type Explanation Critical Values 

A-D Anderson-
Darling 

The Anderson-Darling test is defined as: 

H0: The data follow a specified distribution. 

Ha: The data do not follow the specified 
distribution 

Test 
Statistic: 

The Anderson-Darling test statistic is defined 
as 

 
 
where 

 
F is the cumulative distribution function of 
the specified distribution. Note that the Yi are 
the ordered data. 
 
The test is a one-sided test and the 
hypothesis that the distribution is of a specific 
form is rejected if the test statistic, A, is 
greater than the critical value. 
 
(SEMATECH2) 

 

The critical values for the Anderson-Darling test are 
dependent on the specific distribution that is being 
tested.  (SEMATECH2) 
 
For  Normal and Lognormal distributions: 
 

alpha 0.1 0.05 0.025 0.01 

A2crit 0.631 0.752 0.873 1.035 

 
For Weibull and Gumbel distributions: 
 

alpha 0.1 0.05 0.025 0.01 

A2crit 0.637 0.757 0.877 1.038 

 
 
(Annis)  

K-S Kolmogorov-
Smirnov 

The Kolmogorov-Smirnov test is defined by: 

H0: The data follow a specified distribution 

Ha: The data do not follow the specified 
distribution 

Test 
Statistic: 

The Kolmogorov-Smirnov test statistic is 
defined as 

 
where F is the theoretical cumulative 
distribution of the distribution being tested 
which must be a continuous distribution (i.e., 
no discrete distributions such as the binomial 
or Poisson), and it must be fully specified. 
 
(SEMATECH1) 

 

An attractive feature of this test is that the distribution of 
the K-S test statistic itself does not depend on the 
underlying cumulative distribution function being tested. 
Therefore, the critical values are universal. (SEMATECH1) 
 
For samples with more than 35 values: (ERI)  
 

Significance 0.20 0.15 0.10 0.05 0.01 

Critical Value     

√ 
 
    

√ 
 
    

√ 
 
    

√ 
 
    

√ 
 

 



K-S+ 
and 
K-S- 

Kolmogorov-
Smirnov+ 
and 
Kolmogorov-
Smirnov- 

Given a sample of n independent uniforms Ui over [0, 
1], the Kolmogorov-Smirnov+ statistic Dn

+ and 
the Kolmogorov-Smirnov- statistic Dn

-, are defined by  

Dn
+ = max1 <= j <= n(j/n - U(j)),   

Dn
- = max1 <= j <= n(U(j) - (j - 1)/n),   

 
where the U(j) are the Ui sorted in increasing order. 
Both statistics follows the same distribution function, 
i.e. Fn(x) = P[Dn

+ <= x] = P[Dn
- <= x] 

 
(Simard) 

The same from the K-S test. 

CVM Cramér-von 
Mises 

Given a sample of n independent uniforms Ui over [0, 1], 
the Cramér-von Mises statistic Wn

2 is defined by 
Wn

2 = 1/12n + ∑j=1
n(U(j) - (j-0.5)/n)2, 

where the U(j) are the Ui sorted in increasing order. The 
distribution function (the cumulative probabilities) is 
defined as Fn(x) = P[Wn

2 <= x] 
 
(Simard) 

As with the K-S test, the critical values are universal: 
  Significance 

N 0.20 0.15 0.10 0.05 0.01 
2 0.138 0.149 0.162 0.175 0.186 

10 0.125 0.142 0.167 0.212 0.32 
20 0.128 0.146 0.172 0.217 0.33 
30 0.128 0.146 0.172 0.218 0.33 
60 0.128 0.147 0.173 0.220 0.33 

100 0.129 0.147 0.173 0.220 0.34 

 
(ReliaSoftCorp) 

WG Watson G Given a sample of n independent uniforms Ui over [0, 1], 
the G statistic is defined by  

Gn = (n)1/2max1 <= j <= n[j/n - U(j) + bar(U)n -1/2]   

  = (n)1/2(Dn
+ + bar(U)n - 1/2),   

 
where the U(j) are the Ui sorted in increasing 
order, bar(U)n is the average of the observations Ui, 
and Dn

+ is the Kolmogorov-Smirnov+ statistic. The 
distribution function (the cumulative probabilities) is 
defined as Fn(x) = P[Gn <= x] 
 
(Simard) 

From 2R Soft WG CDF code: 
 

  Significance 

N 0.20 0.15 0.10 0.05 0.01 
2 0.609 0.636 0.670 0.718 0.787 

10 0.692 0.728 0.773 0.843 0.979 
20 0.711 0.747 0.794 0.866 1.010 
30 0.719 0.755 0.802 0.875 1.021 
60 0.728 0.765 0.813 0.887 1.034 

100 0.734 0.770 0.818 0.893 1.041 
1000 0.745 0.782 0.831 0.906 1.055 

10000 0.749 0.786 0.834 0.909 1.059 

  

WU Watson U Given a sample of n independent uniforms ui over [0, 1], 
the Watson statistic Un

2 is defined by 
Wn

2 = 1/12n + ∑j=1
n[u(j) - (j-0.5)/n]2,  

Un
2 = Wn

2 - n(bar(u)n -1/2)2. 
where the u(j) are the ui sorted in increasing order, 
and bar(u)n is the average of the observations ui. The 
distribution function (the cumulative probabilities) is 
defined as Fn(x) =P[Un

2 <= x] 
 
(Simard) 

From 2R Soft WU CDF code: 
 

  Significance 

N 0.20 0.15 0.10 0.05 0.01 
2 0.122 0.132 0.143 0.154 0.164 

10 0.116 0.130 0.150 0.183 0.255 
20 0.116 0.131 0.151 0.185 0.262 
30 0.117 0.131 0.151 0.185 0.264 
60 0.117 0.131 0.151 0.186 0.266 

100 0.117 0.131 0.152 0.186 0.267 
1000 0.117 0.131 0.152 0.187 0.268 

10000 0.117 0.131 0.152 0.187 0.268 
 



STATISTICS 

When appropriate, 2R Soft calculates an array of statistics that can be both relevant and pertinent for users 

interested in analyzing the behavior of a data set. 

 

The screenshot above is an example of what the user should expect to find in a Statistics tab. The following 

subsections of this document explain each of the statistics that are calculated by 2R Soft.  

MEAN 

The arithmetic mean of a set of values is the quantity commonly called "the" mean or the average. Given a set of 
samples *  +, the arithmetic mean is: (Weisstein2) 

 ̅  
 

 
∑  

 

   

 

VARIANCE 

For a series of data, the sample variance may be computed as: (Weisstein3) 
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where  ̅ is the sample mean. 
 
Note that the sample variance   

  defined above is not an unbiased estimator for the population variance,   . In 
order to obtain an unbiased estimator for   , it is necessary to instead define a "bias-corrected sample variance": 
(Weisstein3) 
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2R Soft uses the bias-corrected sample variance. 

From the mathematical definition of variance, it is clear that this statistic expresses the dispersion of the data with 

respect to the mean. The larger the variance, the more spread out is the data. 



STANDARD DEVIATION 

The standard deviation formula is very simple: it is the square root of the variance. It is the most commonly used 

measure of spread (Lane2). Hence, an unbiased estimator of the population standard deviation,  , is given by: 
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KURTOSIS 

Kurtosis is a measure of whether the data are peaked or flat relative to a normal distribution. That is, data sets 

with high kurtosis tend to have a distinct peak near the mean, decline rather rapidly, and have heavy tails. Data 

sets with low kurtosis tend to have a flat top near the mean rather than a sharp peak. A uniform distribution would 

be the extreme case. For univariate data Y1, Y2, ..., YN, the formula for kurtosis is: (SEMATECH3) 

         
∑ (    ̅)

  
   

(   )  
 

where  ̅ is the mean,   is the standard deviation, and N is the number of data points. 

SKEWNESS 

Skewness is a measure of symmetry, or more precisely, the lack of symmetry. A distribution, or data set, is 

symmetric if it looks the same to the left and right of the center point. For univariate data Y1, Y2, ..., YN, the formula 

for skewness is: (SEMATECH3) 

         
∑ (    ̅)

  
   

(   )  
 

where  ̅ is the mean,   is the standard deviation, and N is the number of data points. The skewness for a normal 

distribution is zero, and any symmetric data should have a skewness near zero. Negative values for the skewness 

indicate data that are skewed left and positive values for the skewness indicate data that are skewed right. By 

skewed left, we mean that the left tail is long relative to the right tail. Similarly, skewed right means that the right 

tail is long relative to the left tail. Some measurements have a lower bound and are skewed right. For example, in 

reliability studies, failure times cannot be negative. (SEMATECH3) 

QUARTILES (Q1, MEDIAN, Q3) 

The quartiles of a data set are formed by the two boundaries on either side of the median, which divide the set 

into four equal sections. The lowest 25% of the data being found below the first quartile value, also called the 

lower quartile (Q1). The median, or second quartile divides the set into two equal sections. The lowest 75% of the 

data set should be found below the third quartile, also called the upper quartile (Q3). These three numbers are 

measures of the dispersion of the data, while the mean, median and mode are measures of central tendency. 

(EncyclopediaOfStatistics) 

 



BOX-WHISKER DIAGRAM 

Given some data, a box and whisker diagram (or box plot) can be drawn to show the spread of the data. The 

diagram shows the quartiles of the data, using these as an indication of the spread. (MathsRevision.net) 

The diagram is made up of a "box", which lies between the upper and lower quartiles. The median can also be 

indicated by dividing the box into two. (MathsRevision.net) 

The "whiskers" are straight line extending from the ends of the box to the maximum and minimum values: 

(MathsRevision.net) 

 

In 2R Soft, the Box-Whisker diagram also contains a black dot, which marks the arithmetic mean of the generated 

values. 



NETWORK VIEWS 

2R Net can graph the network (nodes and links) so that the users can visualize the system that is being analyzed. 

NORMAL VIEW 

Normal View is a graph of the network where the nodes are placed in a two-dimensional Euclidean Plane in 

accordance with their coordinates and the existing links are then shown with their respective direction. To obtain 

this type of graph, the user must navigate through the View menu and select the Normal Graph option: 

 

The result: 

 

Please note that the origin (coordinate [0,0]) is located at the top left corner. The X coordinate increases to the 

right, while the Y coordinate increases downwards. 



RING VIEW 

Ring View is a graph of the network where the nodes are placed in a two-dimensional Euclidean Plane in a circular 

arrangement (ignoring their actual coordinates) and the existing links are then shown with their respective 

direction. Consequently, the network’s connection density can be witnessed. To obtain this type of graph, the 

user must navigate through the View menu and select the Ring Graph option: 

 

The result: 

 

The network shown above is an example of high connection density, given that the center of the graph is 

occupied by a large number of links. 



NODE-LEVEL ANALYSIS 

STATISTICS OF A NODE 

THEORY 

Network nodes (or graph vertices) have different metrics that can be of interest to determine their role and 

influence within a network. 

DEGREE IN 

The number of inward directed graph edges from a given graph vertex in a directed graph (Weisstein). That is, the 

amount of incoming links for a node. 

 

DEGREE OUT 

The number of outward directed graph edges from a given graph vertex in a directed graph (Weisstein). That is, 

the amount of outgoing links for a node. 

 

DEGREE CENTRALITY 

Degree is often interpreted in terms of the immediate risk of node for catching whatever is flowing through the 

network (such as a virus, or some information). For a graph G: = (V, E) with n vertices, the degree centrality CD(v) 

for vertex v is (Wikipedia 2011): 

 

 

BETWEENNESS CENTRALITY 

Vertices that occur on many shortest paths between other vertices have higher betweenness than those that do 

not. 

For a graph G: = (V, E) with n vertices, the betweenness CB(v) for vertex v is computed as follows (Wikipedia 2011): 

1. For each pair of vertices (s, t), compute all shortest paths between them. 

2. For each pair of vertices (s, t), determine the fraction of shortest paths that pass through the vertex in question 

(here, vertex v). 

3. Sum this fraction over all pairs of vertices (s, t). 

 



Or, more succinctly: 

 

Where σst is the number of shortest paths from s to t, and σst(v) is the number of shortest paths from s to t that 

pass through a vertex v. This may be normalized by dividing through the number of pairs of vertices not including 

v, which is (n − 1)(n − 2) for directed graphs. 2R Net uses the normalized measure of betweenness. 

 

CLOSENESS CENTRALITY 

In the network theory, closeness is a sophisticated measure of centrality. It is defined as the mean geodesic 

distance (i.e., the shortest path) between a vertex v and all other vertices reachable from it (Wikipedia 2011): 

 

where     is the size of the network's 'connectivity component' V reachable from v. Closeness can be regarded 

as a measure of how long it will take information to spread from a given vertex to other reachable vertices in the 

network. 

 

CLUSTERING COEFFICIENT 

The local clustering coefficient of a vertex in a graph quantifies how close its neighbors are to being a clique 

(complete graph). Duncan J. Watts and Steven Strogatz introduced the measure in 1998 to determine whether a 

graph is a small-world network. 

A graph G = (V, E) formally consists of a set of vertices V and a set of edges E between them. An edge eij connects 

vertex i with vertex j. 

The neighborhood N for a vertex vi is defined as its immediately connected neighbors as follows: 

 

We define ki as the number of vertices, | Ni |, in the neighborhood, Ni, of a vertex. 

The local clustering coefficient Ci for a vertex vi is then given by the proportion of links between the vertices within 

its neighborhood divided by the number of links that could possibly exist between them. For a directed graph, eij is 

distinct from eji, and therefore for each neighborhood Ni there are ki(ki − 1) links that could exist among the 

vertices within the neighborhood (ki is the total (in + out) degree of the vertex). Thus, the local clustering 

coefficient for directed graphs is given as (Wikipedia 2011): 

 



INPUT 

To query the statistics of a node, a user must navigate through the Node menu and select the Statistics of a Node 

option: 

 

A new window appears with a drop-down menu containing all of the nodes in the network. 

OUTPUT 

After selecting the node of interest and pressing the Refresh button, the node’s statistics are displayed: 

 

Refer to the Theory section for a description of the statistics and how they are calculated. Below the main 

statistics, the nodes that are directly connected to the queried node in an incoming or outgoing direction are 

listed. The Result pane has a scroll bar to the right-hand side that has to be used in order to view the entire 

output data. 

 



OVERALL STATISTICS ANALYSIS 

THEORY 

The Statistics of a Node option focuses on a single node in the network. Nonetheless, the behavior of a statistic, 

such as connectivity or clustering coefficient, throughout the entire network is also important. This is why an 

Overall Statistics Analysis option is provided. The same statistics described in the previous Theory section are the 

subject of study, but this time the objective is generalization rather than specificity. 

INPUT 

To analyze the tendency of a node statistic, a user must navigate through the Node menu and select the Overall 

Statistics Analysis option: 

 

The user must then select the statistic to be analyzed and press the OK button: 

 

OUTPUT 

The output comes in the form of a Normalized Histogram and a Cumulative Histogram for the values of the statistic 

calculated on all of the network’s nodes, along with an array of statistics regarding the calculated values: 

 

To understand these results, refer to the Normalized and Cumulative Histograms section and the Statistics section 

of this document. 

 



NETWORK-LEVEL ANALYSIS 

ARE A AND B CONNECTED? 

THEORY 

When dealing with a large graph (or network), G (V, E), with V being the set of vertices comprising the graph and E 

the set of edges connecting them, the question “Are A and B connected?” for a pair of vertices (or nodes) [A, B] is 

of great importance. If the network is large enough, the computational time required to answer such question can 

be considerably large. While a Shortest Path algorithm can provide us with an answer to the question, it also 

requires an unnecessary amount of computation, since it will try to find the exact path that optimizes the 

displacement from A to B. A comparison of computational complexity is shown below: 

Algorithm Type Worst-Case Time Complexity 

Dijkstra Shortest Path  (| | ) 

Bellman-Ford Shortest Path  (| |  | |) 

Depth-First Connectivity Tree  (| |  | |) 

Breadth-First Connectivity Tree  (| |  | |) 

As the table above shows, if one is not interested on the path from A to B, but only on knowing whether they are 

connected or not, the Depth-First and Breadth-First algorithms are faster at providing an answer. 

DEPTH-FIRST SEARCH 

Depth-first search (DFS) is an algorithm for traversing or searching a tree, tree structure, or graph. One starts at 

the root (selecting some node as the root in the graph case) and explores as far as possible along each branch 

before backtracking (FilePie 2011). 

For the following graph: 

 

a depth-first search starting at A, assuming that the left edges in the shown graph are chosen before right edges, 

and assuming the search remembers previously-visited nodes and will not repeat them (since this is a small graph), 

will visit the nodes in the following order: A, B, D, F, E, C, G. 

 

 

 

http://www.filepie.us/?title=File:Graph.traversal.example.svg


BREADTH-FIRST SEARCH 

In graph theory, breadth-first search (BFS) is a graph search algorithm that begins at the root node and explores all 

the neighboring nodes. Then for each of those nearest nodes, it explores their unexplored neighbor nodes, and so 

on, until it finds the goal. This results in a different order of traversal with respect to the previous algorithm (FilePie 

2011): 

Order in which nodes are expanded, DFS Order in which nodes are expanded, BFS 

  

 

INPUT 

To query the connectivity between two nodes, a user must navigate through the Network menu and select the Are 

A and B Connected? option: 

 

A new dialog window comes up asking for the search algorithm to be employed and the pair of nodes to test: 

 

Refer to the Theory section to understand the differences between Depth-First and Breadth-First searches. 

 



OUTPUT 

After clicking the Run button, 2R Net shows a message indicating whether or not the two nodes are connected: 

Positive Answer Negative Answer 

  

Of course, the Depth-First and Breadth-First algorithms provide consistent answers. The means of getting to the 

answers differ, but the results are always the same. 

 

 

 



CLUSTERING ANALYSIS 

In the words of (Dipartimento Di Elettronica E Informazione): 

Clustering can be considered the most important unsupervised learning problem; so, as every other problem of 

this kind, it deals with finding a structure in a collection of unlabeled data. A loose definition of clustering could be 

“the process of organizing objects into groups whose members are similar in some way”. A cluster is therefore a 

collection of objects which are “similar” between them and are “dissimilar” to the objects belonging to other 

clusters. We can show this with a simple graphical example: 

 

INTRODUCTION TO CLUSTERING ALGORITHMS 

Clustering algorithms can be classified into 4 different groups (Dipartimento Di Elettronica E Informazione): 

1. Exclusive clustering: if a certain datum belongs to a definite cluster then it could not be included in 

another cluster. 

2. Overlapping clustering: uses fuzzy sets to cluster data, so that each point may belong to two or more 

clusters with different degrees of membership. 

3. Hierarchical clustering: based on the union between the two nearest clusters. The beginning condition is 

realized by setting every datum as a cluster. After a few iterations it reaches the final clusters wanted. 

4. Probabilistic clustering: a completely probabilistic approach. 

An important step in any clustering is to select a distance measure, which will determine how the similarity of two 

elements is calculated. This will influence the shape of the clusters, as some elements may be close to one another 

according to one distance and farther away according to another (Temporis). Common distance measures include 

the Euclidean distance, Manhattan distance, Mahalanobis distance, and Hamming distance. In the case of 2R Net, 

LINK WEIGHT is always used as the distance measure during clustering analysis. Refer to the Weight Matrix 

section for more information on the way link weight is calculated. 

 

 



EDGE BETWEENNESS 

THEORY 

An algorithm for computing clusters (community structure) in graphs based on edge betweenness. The 

betweenness of an edge is defined as the extent to which that edge lies along shortest paths between all pairs of 

nodes. This algorithm works by iteratively following the 2 step process (GIRVAN, #160 et al. 2002):  

 Compute edge betweenness for all edges in current graph. 

 Remove edge with highest betweenness  

Running time is: O(kmn) where k is the number of edges to remove, m is the total number of edges, and n is the 

total number of vertices. For very sparse graphs the running time is closer to O(kn^2) and for graphs with strong 

community structure, the complexity is even lower.  

INPUT 

To begin a clustering analysis in 2R Net, the user must navigate through the Network menu and select the 

Clustering option: 

 

After selecting Edge Betweenness as the clustering algorithm of choice, any relevant parameters are requested: 

 

 # Edges to remove: the number of edges to be progressively removed from the graph. Refer to the Theory 

section to understand the effects of this parameter. 

OUTPUT 

Jump to the Clustering Output section to learn about the results obtained after this type of analysis is run. 

 

 



K-MEDOIDS CLUSTERING 

THEORY 

K-Medoids is an exclusive clustering algorithm for partitioning N data points into K disjoint subsets Sj containing Nj 

data points so as to minimize the sum-of-squares criterion (Weisstein): 

  ∑∑|     |
 

    

 

   

 

Where    is a vector representing the nth data point and    is the geometric centroid (average of all coordinates) 

of the data points in Sj. 

The algorithm consists on a simple re-estimation procedure as follows (Weisstein). Initially, the data points are 

assigned at random to the K sets. 

 For step 1, the centroid (average of all instances in the set) is computed for each set (or cluster) and the 

instance closest to such mean is taken as the cluster’s medoid. (Abeel) 

 In step 2, every point is re-assigned to the cluster whose medoid is closest to that point. 

 These two steps are alternated until a stopping criterion is met, i.e., when there is no further change in 

the assignment of the data points.  

INPUT 

To begin a clustering analysis in 2R Net, the user must navigate through the Network menu and select the 

Clustering option: 

 

After selecting K-Medoids as the clustering algorithm of choice, any relevant parameters are requested: 

 



PARAMETERS 

When running a one-level clustering analysis, meaning that clusters are only calculated from the original network 

and no sub-clusters within those clusters are to be calculated, a single parameter has to be entered: 

 

 # Clusters: the number of clusters that the user wants to obtain from the clustering process. 

MULTI-LEVEL CLUSTERING 

If sub-clusters within clusters are to be calculated, the user will have to activate the Multi-Level Clustering 

checkbox. This will require additional information to be entered in the Multi-Level region of the clustering 

window: 

 

 Unsupervised Multi-Level: for each calculated cluster, sub-clusters will be found until a point is reached 

where the sub-sub-…-sub-cluster cannot be divided into #Clusters clusters (5 in the screen above). 

Therefore, for the example above, a tree of clusters is obtained in which each “node” (cluster) has either 0 

or 5 “nodes” (clusters) as childs. 

 

 Predefined # of Levels: this type of multi-level clustering stops after N levels of clusters are found (limited 

depth of search). For each calculated cluster, sub-clusters will be found until a point is reached where the 

sub-sub-…-sub-cluster cannot be divided into #Clusters clusters (5 in the screen above) or until N levels of 

clusters have already been calculated. Therefore, for the example above, a tree of clusters is obtained in 

which each “node” (cluster) has either 0 or 5 “nodes” (clusters) as childs, and the maximum depth of 

search is of sub-sub-clusters with respect to the original clusters. 

OUTPUT 

Jump to the Clustering Output section to learn about the results obtained after this type of analysis is run. 



MCL (MARKOV CLUSTER ALGORITHM) 

THEORY 

In the words of (JUNG 2011): 

The basic idea underlying the MCL algorithm is that dense regions in sparse graphs correspond with regions in 

which the number of k-length paths is relatively large, for small k in N, which corresponds to multiplying 

probabilities in the matrix appropriately. Random walks of length k have higher probability (product) for paths with 

beginning and ending in the same dense region than for other paths(JUNG 2011).  

The algorithm starts by creating a Markov matrix from the graph, for which first the adjacency matrix is added 

diagonal elements to include self-loops for all nodes, i.e., probabilities that the random walker stays at a particular 

node. After this initialization, the algorithm works by alternating two operations, expansion and inflation, 

iteratively recomputing the set of transition probabilities. The expansion step corresponds to matrix multiplication 

(on stochastic matrices), the inflation step corresponds with a parameterized inflation operator Gamma_r, which 

acts column-wise on (column) stochastic matrices. 

The inflation operator transforms a stochastic matrix into another one by raising each element to a positive power 

p and re-normalizing columns to keep the matrix stochastic. The effect is that larger probabilities in each column 

are emphasized and smaller ones deemphasized. On the other side, the matrix multiplication in the expansion step 

creates new non-zero elements, i.e., edges. The algorithm converges very fast, and the result is an idempotent 

Markov matrix, M = M * M, which represents a hard clustering of the graph into components.  

Expansion and inflation have two opposing effects: While expansion flattens the stochastic distributions in the 

columns and thus causes paths of a random walker to become more evenly spread, inflation contracts them to 

favored paths.  

This description is based on the introduction of Stijn van Dongen's thesis Graph Clustering by Flow Simulation 

(2000); for a mathematical treatment of the algorithm and the associated MCL process, see there.  

 

INPUT 

To begin a clustering analysis in 2R Net, the user must navigate through the Network menu and select the 

Clustering option: 

 

 

 

 

 



After selecting MCL as the clustering algorithm of choice, any relevant parameters are requested: 

 

PARAMETERS 

When running a one-level clustering analysis, meaning that clusters are only calculated from the original network 

and no sub-clusters within those clusters are to be calculated, some parameters have to be entered: 

 Gamma: inflation exponent for Gamma operator. 

 Loop Gain: values for cycles. 

 Max Residual: maximum difference between row elements and row square sum (measure of 

idempotence). 

 Max Zero: maximum value considered zero for pruning operations. 

 Affinity Matrix 

o Use Connectivity: the Connectivity Matrix will be used as the MCL Affinity Matrix. 

o Use Similarities: the Weight Matrix will be used to generate the MCL Affinity Matrix. Since a 

higher link weight indicates a lower affinity, cell [i, j] of the affinity matrix will be taken to be 

equal of 1/wi,j, where wi,j is the weight of the link from node i to node j. 

To fully understand the meaning of these parameters, it is necessary to go over Stijn van Dongen's thesis Graph 

Clustering by Flow Simulation (2000). If a basic usage of MCL is needed, the default values of these parameters 

(shown in the screenshot above) should be fine. 

 

 

 

 



USE KERNEL 

If the user wants to apply a kernel to the MCL Affinity Matrix, the Use Kernel checkbox should be selected. This 

leads to the Kernel region being displayed: 

 

Kernels are applied to enhance the differences between affinity values, so that the affinity matrix becomes less 

vague:  

With Gaussian Kernel: 

    {  
 ‖     ‖

 

   

          
                                                    

With Inverse Quadratic Kernel: 

    

{
 

 
 

√‖     ‖
 
  

          

                                                    

In both cases, ‖     ‖ stands for a basic measure of similarity. If ‖     ‖ is large, points    and    are 

said to be “closer” to each other in accordance with the distance measure being used. Such measure 

depends on whether the Connectivity Matrix or the Weight Matrix is being used as the base data for the 

affinity values, as mentioned in the Parameters section. 

MULTI-LEVEL CLUSTERING 

If sub-clusters within clusters are to be calculated, the user will have to activate the Multi-Level Clustering 

checkbox. This will require additional information to be entered in the Multi-Level region of the clustering 

window: 

 

 Unsupervised Multi-Level: for each calculated cluster, sub-clusters will be found until a point is reached 

where the sub-sub-…-sub-cluster cannot be divided. 



 

Predefined # of Levels: this type of multi-level clustering stops after N levels of clusters are found (limited depth of 

search). For each calculated cluster, sub-clusters will be found until a point is reached where the sub-sub-…-sub-

cluster cannot be divided or until N levels of clusters have already been calculated. Therefore, for the example 

above, a tree of clusters is obtained in which the maximum depth of search is of sub-sub-clusters with respect to 

the original clusters. 

 

OUTPUT 

Jump to the Clustering Output section to learn about the results obtained after this type of analysis. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



WEAK COMPONENT 

THEORY 

Finds all weak components in a graph and regards them as separate clusters. A weak component is defined as a 

maximal subgraph in which all pairs of vertices in the subgraph are reachable from one another in the underlying 

undirected subgraph (JUNG 2011).  

Running time: O(|V| + |E|) where |V| is the number of vertices and |E| is the number of edges.  

INPUT 

To begin a clustering analysis in 2R Net, the user must navigate through the Network menu and select the 

Clustering option: 

 

After selecting Weak Component as the clustering algorithm of choice, any relevant parameters are requested: 

 

 In this case, no parameters are required. Refer to the Theory section to understand why. 

 

OUTPUT 

Jump to the Clustering Output section to learn about the results obtained after this type of analysis is run. 



CLUSTERING OUTPUT 

TREE VIEW 

After a clustering analysis is run, the results are displayed in the form of a tree view: 

 

Nodes with a folder icon (clusters and members) can be expanded and contracted by double-clicking on them. 

Every cluster contains: 

 The average shortest path weight between pairs of nodes inside the cluster (<dist.>). 

 A Members folder with a list of all the nodes that comprise the cluster. 

 A list of sub-clusters when applicable (if running a multi-level clustering). 

 

 

 



The tree view provides 4 important options. They are applied on the selected cluster only. The selected cluster is 

the one highlighted by the user by clicking on it. 

 Graph Real: a graph of the selected cluster’s nodes is shown. The members of a cluster are represented 

with a unique color. 

 
 

 Graph Fictitious: a graph of the selected cluster’s sub-clusters is generated, where each sub-cluster is 

represented as a single node corresponding to its medoid. Every sub-cluster’s medoid is graphed with a 

unique color. Most importantly, the links between the medoids are EQUIVALENT LINKS. 

 
 

Equivalent link [AB], connecting cluster A to cluster B in that direction has the following properties: 

o Its demand is equal to the sum of the demands carried by all of the links connecting a node of 

cluster A with a node of cluster B in that direction. 

o Its capacity is equal to the sum of the capacities carried by all of the links connecting a node of 

cluster A with a node of cluster B in that direction. 

o Its weight is the minimum weight out of all of the links connecting a node of cluster A with a 

node of cluster B in that direction. This is because we assume that traveling within the clusters 

has an insignificant cost, so all the traffic from cluster A to cluster B will try to travel through the 

less costly significant segment. 

o Its failure probability is equal to the multiplication of the probabilities of failure of the links 

connecting a node of cluster A with a node of cluster B in that direction. This is because, for the 

two clusters to become disconnected, all of the mentioned links must fail. 



 

 Analyze Real: the selected cluster’s nodes are exported to a new 2R Net window for further analysis. 

 Analyze Fictitious: the selected cluster’s sub-clusters are exported to a new 2R Net window for further 

analysis, where each sub-cluster is represented as a single node corresponding to its medoid. Most 

importantly, the links between the medoids are EQUIVALENT LINKS. 

 

Equivalent link [AB], connecting cluster A to cluster B in that direction has the following properties: 

o Its demand is equal to the sum of the demands carried by all of the links connecting a node of 

cluster A with a node of cluster B in that direction. 

o Its capacity is equal to the sum of the capacities carried by all of the links connecting a node of 

cluster A with a node of cluster B in that direction. 

o Its weight is the minimum weight out of all of the links connecting a node of cluster A with a 

node of cluster B in that direction. This is because we assume that traveling within the clusters 

has an insignificant cost, so all the traffic from cluster A to cluster B will try to travel through the 

less costly significant segment. 

o Its failure probability is equal to the multiplication of the probabilities of failure of the links 

connecting a node of cluster A with a node of cluster B in that direction. This is because, for the 

two clusters to become disconnected, all of the mentioned links must fail. 

 

GENERATE RANDOM NETWORK 

THEORY 

Random networks can be created with different end results in mind. Each algorithm aims for a specific type of 

effect, with special properties in terms of the configuration of nodes and/or links. 

COMPLETE NETWORK 

A complete graph is a graph where every vertex shares an edge with every other vertex. If it is a directed graph, 

then edges must always exist in both directions. On a side note, a complete graph is the least efficient possible 

graph in terms of memory and CPU usage. 

COMPLETE BIPARTITE NETWORK 

 

A complete bipartite graph is a bipartite graph (i.e., a set of graph vertices decomposed into two disjoint sets such 

that no two graph vertices within the same set are adjacent) such that every pair of graph vertices in the two sets 

are adjacent (Weisstein 2011). 



EMPTY NETWORK 

 

An empty graph on n nodes consists of n isolated nodes with no edges. Such graphs are sometimes also called 

edgeless graphs or null graphs (Weisstein 2011). 

 

HYPERCUBE NETWORK 

This is a graph that can be represented by bit strings, so for an n-dimensional hypercube each vertex resembles an 

n-length bit string. Then, two vertices are adjacent if and only if their bitstring differ by exactly one element. 

LINEAR NETWORK 

A linear graph with N vertices has an N-step path that traverses the entire network in a single direction. 

RANDOM NETWORK 

This is the most usual type of algorithm. N nodes are placed randomly and the M links to create are then randomly 

selected from the N*(N-1) possible links. No special properties are expected to result from this type of procedure. 

RING NETWORK 

A ring graph is a graph that contains a single cycle that passes through all its vertices exactly once. For a directed 

graph, the generated edges are oriented consistently around the ring. 

SCALE FREE NETWORK 

Scale-free network is a connected graph, where degrees of vertices are distributed in an unusual way. There are 

many vertices with small degrees and only small amount of vertices with big degrees. 

STAR NETWORK 

This is a graph where every vertex has exactly one edge with a center vertex. 

WHEEL NETWORK 

Reminding a bicycle wheel, a wheel graph has a hub vertex in the center and a rim of vertices around it that are 

connected to each other (as a ring). The rim vertices are also connected to the hub with edges that are called 

"spokes". 

 



INPUT 

To generate a random network, a user must navigate through the Network menu and select the Generate 

Random Network option: 

 

A new dialog window will pop up asking for a variety of parameters: 

 

 Type: the type of network that is to be generated. Refer to the Theory section for information on the 

different types of networks available. 

PARAMETERS IN COMMON 

All of the network generation algorithms have some parameters in common: 

 Max. X/LAT: the X coordinate (or latitude) for each generated node will be in [0, Max. X/LAT]. 

 Max. Y/LON: the Y coordinate (or longitude) for each generated node will be in [0, Max. Y/LAT]. 

 Max. Capacity: the capacity for each generated link will be in [0, Max. Capacity]. 

 Max. Demand: the demand for each generated link will be in [0, Max. Demand]. 

 Failure prob./unit distance: the proportionality factor that will be used to compute failure probabilities 

for the generated links based on the distance covered by them. Refer to the Failure Probability Matrix 

section for more information regarding this parameter. 



UNIQUE PARAMETERS 

 Complete Network 

o Vertex #: number of vertices to be generated. 

 Complete Bipartite Network 

o Vertex #, P1: the number of vertices in the first partition. 

o Vertex #, P2: the number of vertices in the second partition. 

 Empty Network 

o Vertex #: number of vertices to be generated. 

 Hypercube Network 

o Dimension #: dimension of the hypercube. (The length of the bitstrings to be used). 

 Linear Network 

o Vertex #: number of vertices to be generated. 

 Random Network 

o Vertex #: number of vertices to be generated. 

o Edge #: number of links to be generated. 

o Bidirectional: if this checkbox is selected, the edges that are generated are bidirectional (cover 

both directions). 

 Ring Network 

o Vertex #: number of vertices to be generated. 

 Scale Free Network 

o Vertex #: number of vertices to be generated. 

 Star Network 

o Vertex #: number of vertices to be generated. 

 Wheel Network 

o Vertex #: number of vertices to be generated. 

OUTPUT 

The active 2R Net window will be populated with the generated network after the user hits the Generate button. 

 

 

 

 

 

 

 

 

 

 



SHORTEST PATH 

THEORY 

2R Net can run three different shortest path algorithms on a network (or graph), G (V, E), with V being the set of 

vertices comprising the graph and E the set of edges connecting them. Here’s a summary of their computational 

complexity and their use: 

Algorithm Use Worst-Case Time Complexity 

Dijkstra Finding a single shortest path  (| | ) 

Bellman-Ford Finding a single shortest path  (| |  | |) 

Floyd-Warshall Finding the total weight of all 
shortest paths in the network 

 (| | ) 

While the Dijkstra and Bellman-Ford algorithms find the weight and the step-by-step path from a specific node in 

the network to another node, the Floyd-Warshall algorithm gives a matrix of shortest path weights for the entire 

network. Thus, the first two algorithms are more detailed in their answer, but the latter has a wider coverage and 

is much more efficient than running the other two algorithms | |  times for a network-wide analysis. In the case 

of 2R Net, LINK WEIGHT is always used as the distance measure during shortest path analysis. Refer to the 

Weight Matrix section for more information on the way link weight is calculated. 

 

DIJKSTRA ALGORITHM 

Let the node at which we are starting be called the initial node. Let the distance of node Y be the distance from 

the initial node to Y. Dijkstra's algorithm will assign some initial distance values and will try to improve them step 

by step (FilePie 2011). 

1. Assign to every node a distance value: set it to zero for our initial node and to infinity for all other nodes. 

2. Mark all nodes as unvisited. Set initial node as current. 

3. For current node, consider all its unvisited neighbors and calculate their tentative distance. For example, if 

current node (A) has distance of 6, and an edge connecting it with another node (B) is 2, the distance to B 

through A will be 6+2=8. If this distance is less than the previously recorded distance, overwrite the 

distance. All unvisited neighbors are added to an unvisited set. 

4. When we are done considering all neighbors of the current node, mark it as visited. A visited node will not 

be checked ever again; its distance recorded now is final and minimal. 

5. The next current node will be the node with the lowest distance in the unvisited set. 

6. If all nodes have been visited, finish. Otherwise, set the unvisited node with the smallest distance (from 

the initial node, considering all nodes in graph) as the next "current node" and continue from step 3. 

 

 

 

 

 



BELLMAN-FORD ALGORITHM 

The Bellman–Ford algorithm computes single-source shortest paths in a weighted digraph. For graphs with only 

non-negative edge weights, the faster Dijkstra's algorithm also solves the problem. Thus, Bellman–Ford is used 

primarily for graphs with negative edge weights. The algorithm is named after its developers, Richard Bellman and 

Lester Ford, Jr (FilePie 2011). 

Bellman–Ford is in its basic structure very similar to Dijkstra's algorithm, but instead of greedily selecting the 

minimum-weight node not yet processed to relax, it simply relaxes all the edges, and does this |V | − 1 times, 

where |V | is the number of vertices in the graph. The repetitions allow minimum distances to accurately 

propagate throughout the graph, since, in the absence of negative cycles, the shortest path can only visit each 

node at most once. Unlike the greedy approach, which depends on certain structural assumptions derived from 

positive weights, this straightforward approach extends to the general case (FilePie 2011). 

FLOYD-WARSHALL ALGORITHM 

In the words of (FilePie 2011): 

The Floyd–Warshall algorithm compares all possible paths through the graph between each pair of vertices. It is 

able to do this with only Θ(|V|
3
) comparisons in a graph. This is remarkable considering that there may be up to 

Ω(|V|
2
) edges in the graph, and every combination of edges is tested. It does so by incrementally improving an 

estimate on the shortest path between two vertices, until the estimate is optimal. 

Consider a graph G with vertices V, each numbered 1 through N. Further consider a function shortestPath(i, j, k) 

that returns the shortest possible path from i to j using vertices only from the set *         + as intermediate 

points along the way. Now, given this function, our goal is to find the shortest path from each i to each j using only 

vertices 1 to k + 1. 

There are two candidates for each of these paths: either the true shortest path only uses vertices in the set 

{1, ..., k}; or there exists some path that goes from i to k + 1, then from k + 1 to j that is better. We know that the 

best path from i to j that only uses vertices 1 through k is defined by shortestPath(i, j, k), and it is clear that if there 

were a better path from i to k + 1 to j, then the length of this path would be the concatenation of the shortest path 

from i to k + 1 (using vertices in {1, ..., k}) and the shortest path from k + 1 to j (also using vertices in {1, ..., k}). 

If w(i,j) is the weight of the edge between vertices i and j, we can define shortestPath(i, j, k) in terms of the 

following recursive formula: the base case is 

shortestPath(i,j,0) = w(i,j) 

and the recursive case is 

 

This formula is the heart of the Floyd–Warshall algorithm. The algorithm works by first computing 

shortestPath(i, j, k) for all (i, j) pairs for k = 1, then k = 2, etc. This process continues until k = n, and we have found 

the shortest path for all (i, j) pairs using any intermediate vertices. 

 

 



INPUT 

To run a shortest path analysis, a user must navigate through the Network menu and select the Shortest Path 

option: 

 

A new window will show up asking for the algorithm of choice and the pair of node to test (where appropriate): 

 

 Algorithm: the shortest path algorithm to run. Refer to the Theory section for more information. 

 Vertices (Dijkstra and Bellman-Ford only) - ORDER DOES MATTER. The shortest path from A to B isn’t 

necessarily the same as the one from B to A! 

o Start: the node from which the algorithm should start. Only nodes with incoming or outgoing 

links are shown. 

o End: the node at which the algorithm should end. Only nodes with incoming or outgoing links 

are shown. 

 

 

 

 

 

 

 

 



OUTPUT 

DIJKSTRA AND BELLMAN-FORD 

The result pane shows the step-by-step shortest path and the weight associated with each step: 

 

(i, j) refers to the edge going from node i to node j. In the screenshot above, the shortest path from node 0 to node 

6 is being described. The result pane has a scroll bar to the right-hand side that has to be used to scroll through 

the result if the shortest path covers a large number of steps. 

FLOYD-WARSHALL 

A new window pops up containing a matrix of shortest path weights for the entire network: 

 

Cell (i, j) contains the total weight of the shortest path traversing from node i to node j. The matrix can be exported 

to Microsoft Excel by selecting the Export to Excel option from the Data menu located at the top-left corner: 

 



RELIABILITY ANALYSIS 

CONNECTIVITY TYPES 

When testing the reliability of a network, three different connectivity definitions can be employed. A system that is 

highly reliable under one definition of connectivity can be remarkably unreliable when using a different definition 

for the same property. 

 Weak Connectivity: node A is said to be weakly connected to node B if there is a path from A to B in a 

network where link directions are ignored. That is, every existing link is regarded as bidirectional for the 

connectivity test. 

 Normal Connectivity: node A is said to be normally connected to node B if there is a path from A to B OR 

from B to A in the network. 

 Strong Connectivity: node A is said to be strongly connected to node B if there is a path from A to B AND 

from B to A. 

It can be shown that strongly connectivity implies normal and weak connectivity as well. Also, normal connectivity 

implies weak connectivity. 

 

ANALYZABLE SYSTEMS 

Three types of analyzable systems can be derived from a network when studying reliability: 

 The Entire Network: the connectivity definition is applied to every pair of nodes inside the network. If at 

least one pair of nodes is disconnected, then the entire network is said to be disconnected. 

 Pair of Nodes (A<->B): the connectivity definition is applied to a specific pair of nodes (A, B). 

 Path (A->B): this type of system is considered as connected if and only if there is a path from node A to 

node B in that direction. This system has its own definition of connectivity, which is the midpoint 

between normal and strong connectivity of a pair of nodes (the OR is too weak, but the AND is too 

strong). 



CUT SETS 

THEORY 

There are two types of cut sets (Weisstein 2011): 

 Edge-Cut Set: A set of edges of a graph (or network) which, if removed (or "cut"), disconnects the graph. 

 Vertex-Cut Set: A set of vertices of a graph (or network) which, if removed (or "cut"), disconnects the 

graph. 

Clearly, the “disconnects the graph” part of the definition depends on the type of connectivity that is being tested 

(weak, normal, or strong). 

In reliability analysis, only the minimal cut sets are of interest. Those are found by testing sets of only 1 element, 

then testing sets of 2 elements, and so on. If a cut set of N elements contains a previously found cut set of M 

elements, where M < N, then the N-member cut set isn’t a minimal cut set. 

The process of finding cut sets in a network entails testing all of the possible edge or vertex subsets one at a time, 

leading to non-polynomial running times. This is why 2R Net’s user interface provides real-time information about 

the minimal cut sets that have been found and the number of cut sets that have been tested. In addition, the 

algorithm can be stopped at any moment. The following optimizations have been made in 2R Net to reduce the 

running time: 

1. Weak Connectivity and Strong Connectivity network-wide inspection algorithms rely on graph theory 

theorems with computational complexities much lower than the ones associated with the brute-force 

approach. This means that the Normal Connectivity network-wide inspection is considerably slower than 

the other two alternatives, as it requires a brute-force methodology. 

2. When testing vertex cut sets, the vertices are sorted in descending degree order (incoming plus outgoing 

links), so that the vertices with a higher probability of affecting the network as a whole are tested first. 

3. Cut sets containing previously found minimal cut sets aren’t tested. Therefore, the process accelerates as 

more minimal cut sets are found, since the number of remaining possible cut sets is reduced. 

 



INPUT 

To begin a cut set search, the user must navigate through the Reliability menu and select the Cut Sets option: 

 

A new window pops up with a wide array of options: 

 

 The difference between edge-cut sets and vertex-cut sets is covered in the Theory section. Meanwhile, 

the Analyzable Systems and Connectivity Types sections explain the options contained in the Connectivity 

Type and System to Analyze regions. 

 There are three parameters: 

o Max. Cut Set Size: the maximum cut set size to be tested by the algorithm. 

o A and B (only when testing a pair of nodes or a path) 

 Nodes A and B are the initial and final nodes in the A<->B and A->B systems. Note that, 

when analyzing a path (A->B), the order does matter. 

 



OUTPUT 

Cut sets are listed in the Results region. Every line represents a cut set and members of the same cut sets are 

separated by a comma (,). Edge-cut set members are presented in the form H->K, where H->K is the link that goes 

from node H to node K. Meanwhile, vertex-cut set members are presented in the form H, where H is the node ID of 

the vertex in question. 

Edge-Cut Sets Vertex-Cut Sets 

  

Note: the results can be copied (ctrl+c) and pasted (ctrl+v) in an external program (e.g. Microsoft Word). 

 



K-CONNECTIVITY 

THEORY 

A graph (or network) G is said to be k-vertex connected if there does not exist a set of k-1 vertices (or nodes) 

whose removal disconnects the graph (Weisstein 2011). Similarly, a graph (or network) G is said to be k-edge 

connected if there does not exist a set of k-1 edges (or links) whose removal disconnects the graph. 

From the definition, a network’s k-connectivity is found by determining its smallest minimal cut set. If the network 

is initially disconnected, then its k-vertex and k-edge connectivity is equal to 0. 

2R Net’s k-connectivity algorithm is the same as the one used for the Cut Sets option, but is limited to the entire 

network (A<->B and A->B systems don’t make sense in this case) and halts as soon as the first minimal cut set is 

found. 

INPUT 

To calculate the k-connectivity of a network, a user must navigate through the Reliability menu and select the k-

connectivity option: 

 

A new dialog window is shown asking for some parameters: 

 

 The difference between k-vertex connectivity and k-edge connectivity is covered in the Theory section. 

Meanwhile, the Connectivity Types section explains the options contained in the Connectivity Type 

region. Keep in mind that the Entire Network is the system being analyzed in this case. 



 

OUTPUT 

A message pops up as soon as the first minimal cut set is found. The message mentions the cut set that led to the 

k-connectivity conclusion: 

K-Edge Connectivity Message K-Vertex Connectivity Message 

  

Cut set members are separated by a comma (,). Edge-cut set members are presented in the form H->K, where H->K 

is the link that goes from node H to node K. Meanwhile, vertex-cut set members are presented in the form H, 

where H is the node ID of the vertex in question. 

 

MAX. FLOW (EDMONDS-KARP) 

THEORY 

In the words of (Wikipedia 2011): 

The Ford–Fulkerson algorithm (named for L. R. Ford, Jr. and D. R. Fulkerson) computes the maximum flow in a flow 

network. It was published in 1956. The name "Ford–Fulkerson" is often also used for the Edmonds–Karp 

algorithm, which is a specialization of Ford–Fulkerson. 

The idea behind the algorithm is very simple: As long as there is a path from the source (start node) to the sink 

(end node), with available capacity on all edges in the path, we send flow along one of these paths. Then we find 

another path, and so on. A path with available capacity is called an augmenting path. 

Let G(V,E) be a graph, and for each edge from u to v, let c(u,v) be the capacity and f(u,v) be the flow. We want to 

find the maximum flow from the source s to the sink t. After every step in the algorithm the following is 

maintained: 

Capacity 

constraints:  

The flow along an edge cannot exceed its capacity. 

Skew 

symmetry:  

The net flow from u to v must be the opposite of the net 

flow from v to u (see example). 

Flow 

conservation: 
 

That is, unless u = s or w = t. The net flow to a node is zero, 

except for the source, which "produces" flow, and the sink, 

which "consumes" flow. 



This means that the flow through the network is a legal flow after each round in the algorithm. We define the 

residual network Gf(V,Ef) to be the network with capacity cf(u,v) = c(u,v) − f(u,v) and no flow. Notice that it can 

happen that a flow from v to u is allowed in the residual network, though disallowed in the original network: if 

f(u,v) > 0 and c(v,u) = 0 then cf(v,u) = c(v,u) − f(v,u) = f(u,v) > 0. 

Inputs Graph G with flow capacity c, a source node s, and a sink node t 

Output A flow f from s to t which is a maximum  

1.   for all edges (u,v) 

2. While there is a path p from s to t in Gf, such that cf(u,v) > 0 for all edges :  

1. Find   

2. For each edge   

1.  (Send flow along the path) 

2.  (The flow might be "returned" later) 

The path in step 2 can be found with for example a breadth-first search or a depth-first search in Gf(V,Ef). If you use 

the former, the algorithm is called Edmonds–Karp. 

When no more paths in step 2 can be found, s will not be able to reach t in the residual network. If S is the set of 

nodes reachable by s in the residual network, then the total capacity in the original network of edges from S to the 

remainder of V is on the one hand equal to the total flow we found from s to t, and on the other hand serves as an 

upper bound for all such flows. This proves that the flow we found is maximal. 

INPUT 

2R Net’s Maximum Flow (Edmonds-Karp) algorithm uses the network’s Capacity Matrix as its main input.  

To begin a Maximum Flow analysis, a user must navigate through the Reliability menu and select the Max. Flow 

(Edmonds-Karp) option: 

 

A new window will ask for the source node, A, and the sink node, B, for the analysis: 

 

Refer to the Theory section to understand the role of the source (A) and the sink (B) nodes in this type of analysis. 



OUTPUT 

A message pops up with the maximum flow from A to B under the capacity constraints given by the Capacity 

Matrix. In addition, the critical links are enumerated in the form H->K, where H->K is the link that goes from node 

H to node K. If a critical link’s capacity decreases, the source-sink system’s maximum flow decreases as well.  

 

RELIABILITY BETWEEN 2 NODES 

THEORY 

Reliability analysis circles around failure probabilities, given that it’s the standard way of quantifying risk. In 2R Net, 

failure probabilities of the network’s links and nodes are declared in the Failure Probability Matrix. They can then 

be used in conjunction with a cut set analysis to determine the probability of failure of a two-node system (A<->B) 

or a path (A->B). The cut set finding procedure is the same as the one described in the Cut Set Analysis theory 

section, but the cut sets are then used to calculate the joint failure probability of the system. 

EDGE-CUT SET FAILURE PROBABILITY 

Let {e1, e2, …, em} be a minimal edge-cut set of network G(V, E). Each edge (or link), ei, has a probability of failure 

that is explicitly found in the Failure Probability Matrix. For example, if ei is the edge that connects node A with 

node B, then its failure probability is equal to the value located at cell (A, B) of the previously mentioned matrix. 

Assuming that edge (or link) failures are independent events, the failure probability associated with an edge-cut 

set is given by the multiplication of the failure probabilities of its members: 

  (*          +)  ∏   (    )

*          +

 

VERTEX-CUT SET FAILURE PROBABILITY 

Let {v1, v2, …, vm} be a minimal vertex-cut set of network G(V, E). Each vertex, vi, has a failure probability, but its 

value can be one of two alternatives: 

 Arbitrary value in the Failure Probability Matrix (FPM): as mentioned in the section of this document 

dedicated to the FPM, the FPM’s main diagonal contains the failure probabilities of the network nodes. 

That is, cell (i, i) gives the failure probability of node i. Nonetheless, these cannot be automatically 

calculated and must be manually entered by the user. Thus, this alternative is only useful when the user is 

well-acquainted with the network that is being modeled. 

 Automatically estimated based on edge failure probabilities: if the Failure Probability Matrix is missing 

values in its main diagonal, vertex failure probabilities can be estimated by assuming that a node’s failure 

is equivalent to a total disconnection from the network. That is, a vertex is said to have failed when all 

of its incoming and outgoing links have failed. Consequently, assuming that edge failures are 

independent events,   (  )  ∏   (    )*                     +  

 



Regardless of the chosen alternative and assuming that vertex (or node) failures are independent events, the 

failure probability associated with a vertex-cut set is given by the multiplication of the failure probabilities of its 

members: 

  (*          +)  ∏   (      )

*          +

 

SYSTEM FAILURE PROBABILITY 

If we regard cut sets as independent events, then the system’s failure probability is the probability of at least one 

of its minimal cut sets occurring. The following theorem is of great help in the calculation of that result (ProofWiki 

2011): 

 

From this theorem, one may assert that a system’s failure probability resulting from its minimal cut sets can be 

calculated as: 

  (      )    ∏ ,    (       )-

                

 

 



INPUT 

To investigate the reliability of a system comprised by two nodes, a user must navigate through the Reliability 

menu and select the Reliability Between 2 Nodes option: 

 

A new window pops up with a wide array of options: 

 

 The differences between edge-cut set and vertex-cut set failure probability calculations are discussed in 

the Theory section. Meanwhile, the Analyzable Systems and Connectivity Types sections explain the 

options contained in the Connectivity Type and System to Analyze regions. 

 If the Pf(Vertex) based on Pf of edges checkbox is ticked, the second alternative mentioned in the Vertex-

Cut Set Failure Probability section is employed. Otherwise, the first alternative (matrix values) is applied. 

 A and B 

o Nodes A and B are the initial and final nodes in the A<->B and A->B systems. Note that, when 

analyzing a path (A->B), the order does matter. 

 

 

 

 

 



OUTPUT 

The result table is filled out as new minimal cut sets are found. It has four columns: 

 Cut Set:  Cut set members are separated by a comma (,). Edge-cut set members are presented in the form 

H->K, where H->K is the link that goes from node H to node K. Meanwhile, vertex-cut set members are 

presented in the form H, where H is the node ID of the vertex in question. 

 Cut Set Pf: the probability of failure of the specific cut set as an independent event. Refer to the Theory 

section for information on how this is calculated. 

 Delta Pf: the system failure probability increase that the cut set generated with respect to the previous 

value of the Pf column. That is, (Delta Pf)i = Pfi – Pfi-1. 

 Pf: the resulting system failure probability after the cut set was found.  Refer to the Theory section for 

information on how this is calculated. 

 

The result table’s contents can be easily exported to Microsoft Excel with the Export to Excel button located 

below it. 

If two or more minimal cut sets have been found, a Pf vs Cut Sets Found plot pops to show the system failure 

probability’s convergence: 

 

As the number of minimal cut sets increases, the contribution of each new individual cut set towards the system’s 

failure probability lowers in significance to the point where a clear asymptote in the Pf value is reached. In the 

graph shown above, the asymptote was reached after 22 cut sets were found. Given that the cut set finding 

process has non-polynomial running time, it is usually impractical to test all the possible cut set combinations. 

Hence, the Pf convergence point is what the user should employ as his analysis termination criterion. 



After the user hits the Stop button, the Graph Selected Cut Set and the Graph All Cut Sets buttons become 

activated: 

 

The Graph All Cut Sets button generates a view of the network in which the cut sets are displayed in red. If edge-

cut sets are being used, thicker links indicate a cut set with a higher failure probability. On the other hand, if 

vertex-cut sets are being used, larger nodes indicate a cut set with a higher failure probability. 

All Edge-Cut Sets View All Vertex-Cut Sets View 

  

If the user wants to view a specific cut set, he must select the cut set in the result table (left click) and then hit the 

Graph Selected Cut Set button. A network view is generated in which the cut set is displayed in red. 

One Edge-Cut Set View One Vertex-Cut Set View 
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 A number of recent studies have focused on the statistical properties of networked systems 
such as social networks and the Worldwide Web. Researchers have concentrated particularly on 
a few properties that seem to be common to many networks: the small-world property, power-
law degree distributions, and network transitivity. In this article, we highlight another property 
that is found in many networks, the property of community structure, in which network nodes 
are joined together in tightly knit groups, between which there are only looser connections. We 
propose a method for detecting such communities, built around the idea of using centrality 
indices to find community boundaries. We test our method on computer-generated and real-
world graphs whose community structure is already known and find that the method detects 
this known structure with high sensitivity and reliability. We also apply the method to two 
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